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Using the Keyboard

This document will provide the user with keyboard functionality information for Vision 8.

There are three major groups of keys on your keyboard:

¢ Action Keys
* Number Keys

* Function or F-keys

Scroll down for each group above for a list and explanation.

Action Keys

<Tab>

<Shift> - <Tab>
<Home>
<End>

<Pg Up>

<Pg Dn>

<>

<>

<Delete>

<Back Space>

Alternative to the <Enter> key in many cases -- accepts the current entry
and moves the cursor forward to the next entry field.

Moves the cursor backward to the previous entry field.

Moves the cursor to the first item in a pick list or the first field in a line.
Moves the cursor to the last item in a pick list or the last field in a line.
Displays the previous page of items in a pick list or scrolling list.
Displays the next page of items in a pick list or scrolling list.

Scrolls up a pick list or scrolling list one item at a time. On some screens
(e.g., Construction Detail} it can be used to move backward from one
field to the next in the same way as the <Shift-Tab>.

Scrolls down a pick list or scrolling list one item at a time. On some
screens (e.g., Construction Detail) it can be used to move forward from
one field to the next in the same way as the <Tab>.

Used to delete the character to the right of the cursor or the contents of
a field or line in a table if it is highlighted.

Used to delete the character to the left of the cursor or the contents of a
field if it is highlighted.
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< &> Used to move the cursor left within an entry field without erasing
characters.

<> Used to move the cursor right within an entry field without erasing
characters.

Numeric Keys
There are two sets of number keys on most keyboards:
e Those located in a row above the letter keys.

» Those in a block to the far right of the keyboard, called a keypad.

You may use either set of number keys in the Real Estate program. However, if you choose
to use the keypad, be sure that the Number Lock light is on. Press the <Num Lock> key to
toggle on or off.

Function Keys

The following keys can be used as shortcuts to accomplish their corresponding function

<F1> Help Brings up on-line help for the screen or a field.

<F2> Parcel Selection Brings up the Select Parcel box to select a new or existing
parcel.

<F3> Next>> Jumps to the next screen in navigation tree sequence.

<F5> Print Field Card Prints the current property card.

<F6> Pick List Brings up the pick list for a field if available.

<F7> Legal Information Jumps to the Legal Information section.
<F8> Land Information Jumps to the Land Lines section.

<F9> Building Information Jumps to the Construction and Building Information section.

<F10> Building Sketch Jumps to the Building Sketch section.
<F11> Photo Jumps to the Photo section.
<F12> Income System Jumps to the Income System section.
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Using the Mouse

This document will provide the user with mouse functionality information for Vision 8.

Common actions taken with a mouse are:

Click To press and release the left mouse button once.

Double-click To press and release the left mouse button twice in quick succession.
Right-click  To press and release the right mouse button once.

Drag To hold down the left mouse button while moving the mouse.

Select To highlight or mark text in an entry field or choose an option by clicking the item
field in anticipation of taking some action (like changing, erasing, etc.).

De-select To un-mark or un-highlight text by selecting another item or clicking away from the
selected item.

Scroll To use the middle scroll button on the mouse to move an on-screen scroll bar
upwards and downwards.
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Using Pick Lists

This document will walk the user through using Pick Lists in Vision 8. Many data entry fields are equipped
with a "pick list" where you can choose a value from a list of values permitted for that field. These pick
list values are generally defined in the Admin Module.

Click on any Property Factors Utilities box to see a pick list drop down menu example.

- Soees 0 Ppe] Riaer v o Mewn It Fret Glwe - Toge 0% 4t -
Lty ' Sowet 0% b urver * Poodesy 07 N4 i S Tyme 00 WA
mates CET l Swwer (0 N4 *  mmement X N/A - Loason V1 Avy -
1 Pus Nater
it faciors
g Sulo Mha & - G Aempon - Frontage Ge Area O
Comre= Sauly a1 - Focket Nbeo Sot frorisge O Penrmeter G Peremeter 2

To select an item from a pick list following the steps provided below:
1. Display a pick list by clicking the drop down arrow on one of the fields or by pressing the
<F6> key when the cursor is located in the field.

2. Find the code that contains the information you would like to populate the field with. If
necessary, scroll through the list using the up and down arrow keys, the scroll bar or the
<Pg Up> and <Pg Dn> keys.

3. Click the corresponding item to highlight it. An item must be highlighted for the field to
populate.

4. Single left-click the item to close the box and populate the value in the selected field.
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How to Select Data and Make
Changes

This document will walk the user through standard processes for entering & editing data in Vision 8.
Common Selection Options

Choosing a specific field on a screen indicates to the system that you would like edit that field. The
current information becomes highlighted when you choose the field. If there is no data currently in
the field, only the cursor will show in the field.

To select a field:

1. Repeatedly press the <Enter> or <Tab> key until the cursor lands on the
desired field.

2. Use the mouse to select the desired field by using left-click.

Select an entire line in a list or table:

1. Scroll up and down in a list by using the Up and Down arrow keys, <PgUp>
and <PgDn> keys, or the scroll bars on the screen if they are provided.

2. Use the mouse to click the grayed arrow on the left of the desired line. The
line will highlight and the arrow will turn black, as in the example below.
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To place/remove a mark in a checkbox:

1. Repeatedly press the <Enter> or <Tab> key until the cursor moves to and
highlights the desired check box.

2. Once you are on the checkbox, press the <Spacebar> to check the box. Press
it again to clear the check mark.

3. Alternatively, use the mouse to click the desired box by using left-click. Click
it again to clear the check mark.

To select a "radio button" option:

¢ Only one "radio button" can be selected at any one time.
¢ Clicking a radio button turns it on.

» Clicking a different button turns the new one on and the first one off
automatically.

* In the example below, the Column View Option can either be Show Parcel
Data OR Show all Table Data, the Show Preview Report Columns and Data OR
Show Selected Report Columns and Data can be selected, and the Report
Type may only be Tabular OR Matrix.

| Report Wizard 1 3

| Select Tables and Columns

| select a sample row of data Column View Options Report Type M
| @ Show Parcel Data [
| © Show Al Table Data ®Tabular "~
‘ Show Frendly Names O Matrix

' Show Active Parcel St
|

@ Show Preview Report Columns and Data © Show Selected Report Columns and Data
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Report Wizard

Select Tables and Columns

select a sample row of data Column View Options Report Type
s ] © Show Parcel Data [
© 1@ 10 @ Show All Table Data JEBta) A
Show Friendly Names 2 ® Matrix
Show Active Parcel 5

| © Show Preview Report Columns and Data @ Show Selected Report Columns and Data

Drop-Down List:

Only one item in a drop-down list can be selected. When the drop-down list is inactive only a single

value item will appear. When activated, it displays a drop-down list of values for a user to select
from.

You can navigate to find their desired selection within a drop-down list by:

e Using a scrollbar

¢ Pressing the keyboard navigation keys (up-arrow, down-arrow , <PgUp> and
<PgDn>)

* Entering at least one character from the keyboard - in the case of a lengthy

but ordered list, this strategy can propel one to the general section of entries
beginning with the selected character.

Style Codes

Style: | A - All Property Types v

A - All Property Types |

C - Commercial .

b, M - Condo Mains

R - Residential

U - Condos -
V - Vacant g

Ty VLT ’ el =,
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File Menu

This document will walk the user through the options under the File menu heading of Vision 8.

Clicking the File menu heading will open the options available within.

| Cards Reports Utilities  Help
¥ RealEstate , g o)
Sales Analysis

Comip Sales Snapshot
Personal Property

Printer Setup
Switch Database
User Preference

Bt Adt-F4

The first four options under the File menu give you access to Visions modes of operation. These
options are as follows:

Real Estate - This is the default operating mode when you click the Appraisal Vision icon on your
desktop. In this mode you view, create and maintain the master Real Estate database (parcel
information) and the master Real Estate tables. If you display the File menu after logging on, you see
a check next to this Real Estate option.
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: 'lfl Real Estate

Sales Analysis

Comp Sales Snapshot
Personal Property

Printer Setup

Switch Database
User Preference

Exit Alt-F4

Sales Analysis - In this operating mode the system uses the Sales Analysis database —an extract or
subset copy of the master Real Estate database. You use this database and the sales options on the
Reports menu to complete assess/sales-ratio analysis. Selecting this option displays the Select Parcel
dialog box. If you display the Sales Analysis menu after choosing this mode on, you see a check next
to this Sales Analysis option.

| Real Estate

‘l ¥ | Sales Analysis %
! Comp Sabes Snapshot
|

Personal Property
 Printer Setup
! . Switch Database
| User Preference

Ent Alt-r4

Comp Sales Snapshot - In this mode the system stores complete parcel information at the time of
each sale from the Master Real Estate File or those sale files at the time of extraction. If you display
the Comp Sales Snapshot menu option after choosing this mode on, you see a check next to this
Comp Sales Snapshot option.
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Real Estate
| Sales Analysis
| Comp S&ls Snapshot-
Personal Property

.‘I

Printer Setup
Switch Database
User Preference

Exit Alt-F4

Personal Property - In this operating mode the system provides access to Personal Property
accounts. You can view and maintain all items of taxable Personal Property. Selecting this option
displays the Select Personal Property Account dialog box. If you display the Personal Property menu
after choosing this mode on, you see a check next to this Personal Property option.

Real Estate

Sales Analysis
. Comp Sales Snapshot
[{¥ | Personal Property
Printer Setup
Switch Database

User Preference

Exit Alt

Other File menu items include:

Printer Setup — This option is carried over from previous versions where it was used to displays the
Choose Vision Printer dialog box where you can select a printer as the Vision default or one to be
used for the current session. In Vision 8 you can now use window’s printer setup options.

Switch Database — Choosing this menu option will prompt you with a pop-up asking “Are you sure
you want to switch databases?”
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Choosing the ‘Yes’ option will close all open dialog boxes and display the User Login dialog box
where you can select a different database.

0 Are you sure you want to switch databases?

User Preference — Choosing this menu option will open the User Preferences dialog box where you
can change your Default Folder Path for Import/Export option.

E Real Estate
Sales Analysis
Comp Sales Snapshot
Personal Property |

Printer Setup

Switch Database

Exit Air-F4
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Default Foider Path for import/Export :

Exit - Exit the system. You can also exit the system by clicking the X-box in the upper right corner of
the window or by the F4 key while holding down the Alt key on your keyboard.

¥ Real Estate
 Sales Analysis
- Comp Sales Snapshot
Personal Property

Printer Setup
Switch Database |
User Preference

f;em anes |
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Cards Menu

This document will walk the user through the options under the Cards menu heading of Vision 8.

Clicking the Cards menu heading will open the options available within.

File [Cards] Utilites Help _
% l Print Property Record Card .
[viz o Print Income Card a »

Card menu items include:

Print Property Record Card — Choosing this menu option will open a sub-menu of the following sub-options.

Fle |Cards| Utilities Help _ "

ﬂ Print Property Record Card » : Print Current Parcel F5
siod Print Income Card > Print Current Building
— I
| [ Print Multiple Cards
Parcel 3 [ | 4
Legal Information 8 a J | Print Blank Card »
| ‘ Print All Personal Property Cards

Print Current Parcel — Prints a Property Record Card for the active parcel.
Print Current Building — Prints a Property Record Card for the current building on the active parcel.

Print Multiple Cards — Displays the Custom Parcel Search dialog box.
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After choosing your criteria in this box, choosing the Ok button will open the Order By dialog box. This box allows the user to
choose the order in which the cards will print according to a Primary, Secondary and Tertiary option.

| socondary [None ~ +1 Terary | None

Print Blank Card — Prints a blank card which is called a “template”. Choosing this menu option will open a sub-menu of the
following sub-options.

Residential Template — Prints a blank Residential parcel template.
Condo Main Template — Prints a blank Condo Main parcel template.
Condo Unit Template — Prints a blank Condo Unit parcel template.

Commercial Template - Prints a blank Commercial parcel template.
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File |Cards | Utilities Help

23| PrintProperty Record Card , Print Current Parcel Fs
e
% 1' Print Income Card Y ! Print Current Building
™ - lf" | Print Multiple Cards B 17 e RS = S S
Legal Information I | : Print Blank Card > Residential Template
' 1| | Print All Personal Property Cards Condo Main Template
[ = g X A - Condo Unit Template
|
' | Commercial Template
1 L. .

Print All Personal Property Cards — Choosing this option will print all Personal Property cards. You must be in Personal Property
Mode to use this option.

Print Income Year — This will allow you to select what Income Year you want to print the income card from.

Print Income Card — This option will allow you to print the Income Card from the year you selected.

© 2019 Vision Government Solutions Inc. All Rights Reserved.
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Reports Menu

This document will walk the user through the options under the Reports menu heading of Vision 8.

Clicking the Reports menu heading will open the options available within.

file Cards Reports | Utilities Help
% Sales Analysis

Selup User Reports

Yision 7 Appt

TR

Sales Analysis — This menu item is available only when you are using the Sales Analysis or Comp Sales

Snapshots mode of operation (selected on the File menu). It is grayed out when you're using the master Real
Estate database (default Real Estate mode).

1. Choose the Sales Analysis database from the File Menu. This option will open the Sales
Analysis dialog box.

v Real Estate
Sales Analysis

C es shot
Pe

nber Setis
Switch Database

User Preference

Exit Al-F4

2. Select Reports at the top of the screen. Click on Sales Analysis Reports.
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3. Select the criteria to narrow down your sales analysis. In this example, any parcel with
Model Code 01 and a Sale Date from 01/01/2011 through 12/31/2012. Click Next.

| parcet Setection Acte 0
| acconent Movrbas beom e | '
from | o |
From | ITe }
From | e |
| Oute urcwiastiodhed from | fre | I
ke "1 A

() ot s o ‘
| -1 ___ S |
T al I - -
I.‘zr: e il p— _—;—:J }
| X LI E AR =2 _’= |
k] [
Use Code e S
I » L3 |
I — i - R —
|| Sate Dwin From | L4204 |Te |13731/2012
] It Unguslifed Swes? |
£ Qualifed & 2p Saies |

| W |

= .

4. On the Extract Options page, adjust your settings as required. In this example we are
selecting Create a New Extract. Click Next.
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5. On the Groups Specifications Page, choose the data groupings by clicking on each tab,
then click Next.

6. The Extract Review page will now appear. Review the data and choose which report(s)
to print.
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. |
I > 9 djomnt  » MeansateBren = MeanAgpramed * lsenavSMutio = |Median Sale i = Megen Apprased ® Me! | |
| o 6 41,8843 §154 56667 222 $11,50000 $14250010 [
il 10 51 48, 46831 $20802157 085 000 $175.100.00 :
R 1 $000 $128,300.00 o $000 $128.80000 |
{ |
| 1 16 44368750 $133937.50 051 8000 $124000.00

1

|: | .
j| === v - BN S W T G Aosh)

!  « Back | Cancel | | Fineh |
& }‘,‘y 1. Prior to printing a report, it can be previewed by selecting the Show Preview

‘3.

button.

2. While the system generates the preview, a status message will appear:

Generating preview page 1

Once complete, the preview will appear in the review section of the screen:
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Increase the size of the page by right-clicking on the document and selecting Increase Zoom

Increase Zoom

Decrease Zoom

Close the preview by selecting the Close Preview button:

3. To print the document, click the Print button.
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Print Options

Print Group Summary
Q Print Record Detail

Print Land Residual

4. Clicking the Finish button will close the Report Review screen and return the user to the
Sales Analysis page.

Extract Review Page
Group Summary .MDH I Land Resdusl |
E]rim()wmm
) ) e —— [—— Prni Group Summary
Primarygrouping |ede 2] Secondarygroupeg (None. . *] | pogt Recors Dutat
| | Prnt Land Residual
| E— r—— = P —— P ——— e e R——— oo |
|
|group by Areg Drag s fekd here to group by that feld
| R . ,I
Sayte ~ 0 ||Count = |MeanSelePrice = MuessApprased = MewnA/SRatio = | Medion Sale Price > Median Appased < Ma |
™ 6 108433 §154 56567 w2 $11,500.00 514830000
[ 18 51 $46,468 31 $20802157 085 $000 §17% 100.00
17 1 5000 £$128,50000 B $0.00 $128 300,00
18 16 $43,687.90 £133937.50 081 000 £124/00000
| S Ca— A
bk | Conced | | Fiow |

Setup User Reports — This option is carried over from the previous version and displayed the Available Reports
dialog box where you could add or delete the User Reports available in the Report section. To set up user
reports please see Vision 8’s Admin Module.

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer

131




You are here: Menus > Utilities Menu

OVISION

GOVERNMENT SOLUTIONS

Utilities Menu

This document will walk the user through the options available under the Utilities menu heading of Vision 8.

Clicking the Utilities menu heading will open the options available within.

File Cards |Utilities| Hep

ﬂ ‘ Job Queue
!
Vision 8 Appli Recalc Parcels »
Parcel Parcel Administration »
Legal lnhrj Utilities >
| Sales Analysis Utilities »
| Comp Snapshot Utilities »
| Income Utilities »
Mass Update »
Change Password

Job Queue — This option displays the Process Job Queue for items like but not limited to Recalculation, Sales Analysis Extract,

and Comp Sales Extract.

Recalc Parcels — Choosing this menu option will open a sub-menu of the following sub-options. The sub-option all relate to
utilities you can complete related to recalculation of parcels.

) |
Vision 8 Appli
Parcel

Legal Inforn

‘Recalc Parcels

Fle Cards (Uit Help

1Job Queue

Parcel Administration
Utilities

‘Sales Analysis Utilities

Comp Srapshot Utilities

‘Income Utilities
Mass Update
iChange Password

Y NS

‘Recaic Current Parcel ‘

Recalc Parcel Job Queue ‘

‘Recalc Select Parcels
‘Recalc Reports »
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Recalc Current Parcel — Recalculates the current parcel displayed. The recalculation values are based on recalculation settings
for that parcel.

Recalc Parcel Job Queue — Select this menu option to display the Recalculation Job Queue dialog box.

Recalc Select Parcels — Select this menu option to display the Recalculation Scheduling dialog box.

Recalculation Methods Recalculation Schedule
7/] Recakulate Land Values " Run Now
[7] Recalculate Improvements © Run Later
[¥] Recalculste Cost Building Values RunOn:! 12/13/2018 B
Recalculate Outbuilding and Extra Feature Val =
At 11:18 AM e
(¥] Recalculate Income Values = :
[¥] Refresh Parcel Totals Recurrence: ) Once
1 Recalculats Marshali and Swift Values ' Daily
) Run Comparable Sales ) Weekly
Run Vaiue Trending _ Monthly
© Disabled

iCan:eIi IS:b_edulel

Recalc Reports - Use this option to view or print one of three text files which shows how a parcels value is arrived at. These
three reports are Cost Report, Regression Report and Land Report.

Fie Cards Help _
% - | Job Queue I EE i'.'.T.;
V:s an 8 A;:mii Recalc Parcels 3 i Recalc Current Parcel
Parcel __ Parcel Administration | Parcel Job Queue
LegalInforn  Utilities »|  Recalc Select Parcels | 1
Sales Analysis Utilities > Recalc Reports > : LCost Report F& l
Comp Snapshot Utilities > T RN 1 Fegression Report I
Income Utilitves | ‘ Land Report :
Mass Update L4 |
Change Password |
e |

Parcel Administration — Choosing this menu option will open a sub-menu of the following sub-options. These sub-options
are utilities specific to moving or creating parcel related data.
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File Cards Help i ki
A Job Queve I e
wawa EE =
Vision 8 Appli Recalc Parcels » |
' e f
Parcel ‘ Parcel Administration » ‘Create Vacant Parcels
Legal In‘lon] Utilities » Copy Parcels
} | Sales Analysis Utilities » 'Move Buildings
' 'Comp Snapshot Utilities > .Link Real Estate to Personal Property
| Income Utilities >
.Mass Update » ‘
Change Password ‘
b = — -

Create Vacant Parcels — Selecting this option will open the Create New Vacant Parcels window. Please see the document
How to Create a Vacant Parcel for additional information.

Copy Parcels — Selecting this option will open the Copy Parcel window. Please see the document How to Copy a Parcel for
additional information.

Move Buildings — Selecting this option will open the Move Buildings window.

Utilities - Choosing this menu option will open a sub-menu of the following sub-options. These sub-options contain a diverse
set of utilities and functions in order to modify, import, or extract data in and/or from Vision.

File Cards Help o
A | JobQueue ' EE P
Vision 8 Appli Recalc Parcels > |
Parcel Parcel Administration 3 I v 07 A
Legal Inforn Utilities » ‘ Recyde Bin Functionality »
Sales Analysis Utilities » Copy Exemptions
Comp Snapshot Utilities > Change Unit Prices (5, Ac, Etc)
Income Utilities » Make Future Sales History
Make All Future Parcels Active
'I Change Password ¢
T - | Update Cost Model Binaries
Sdceliol [ ! Clear Betterments
Tl Divis on History = |
Classification & Land Informations | Clear Betterments By Year
Cassificabion & _znd Irfcrmation Clear Growth |
Building Information 'Y ' )
Construrt on Dena s | Save Assessment History
e e | Assessment History Line Removal
Man Berents ! {
ciated Coraos Mailing Labels
featires
s ;3n;,m s Standard Extracts »
| Standard Imports >
Custom Extracts »
| Custom Import »

Recycle Bin Functionality — Selecting this option will allow you to choose between the sub-options of View Building Recycle
Bin or Empty Building Recycle Bin.

Copy Exemptions — Selecting this option will copy exemptions from the current year.
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Change Unit Prices (Sf, Ac, Etc) — Selecting this option will open the Change Unit Prices (Sf, Ac, Etc) dialog box. This is dialog
box is the first step in updating the prices for land unit types.

Change From :

Change To:

Make All Future Sales Current — This process will find any sales marked as “F” for Future and mark them as “C” for
Current. These owners will become the Current Owner for the parcel. Typically, this is done when the billing extract has
been completed.

Make All Future Parcels Active — Parcels can have a status of Active, Inactive, or Future. This process will find all Parcels
marked as “F” for Future and mark them as “A” for Active. Typically, this is done when the billing extract has been
completed.

Clear Betterments — This option ailows you to delete all the Betterments found on the Exemptions screen.

Clear Betterments By Year — This option allows you to delete all the Betterments found on the Exemptions screen by fiscal
year.

Mailing Labels — This option opens the Mailing Labels dialog box allowing you to set criteria by which to create Mailing
Labels.
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Q Mailing Labels
Selection Parceis
9 Advanced Search
@ Existing Report
©ais

| Range Of Parcels |parce] Selective | Advanced | Range Of MBLU |

Parcel Selection | Active v
Accoumt Number From |_ _. -_iTo l ) B |
| District From |__ ___ _ ___lTo |; B _J
Location From | - __JTo | B |
Owners Name From [_ B _-_iTo | = = _ _i
| Date ParcelLastModified From | |10 ]
Res NBHD ( « | ]
| Comm NBHD — - .|
Condo NBHD I - | |
Style P— e |
Model 1 - | |
Building Class [ - ]
Use Type I =l [ - |
Class I s | !

[ =) | ]

| - | Mixed Use
Use Code [ : R _
t s | |

Salle Date From | - ol ]

] Include Unqualified Sales?

] Qualified & 1p Sales

New J[ o J[ cance |

Standard Extracts - This option allows you to choose from a list of standardized, common Extracts.

Standard Imports — This option allows you to choose from a list of standardized, common Imports.

Custom Extracts — This option allows you to choose from a list of customized Extracts.

Custom Import — This option allows you to choose from a list of customized Imports.

Sales Analysis Utilities - Choosing this menu option will open a sub-menu of the following sub-options related to the extract

and copying of data to or from the Sales Analysis database.
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Job au;u_e : EE i‘

Recalc Parcels »

Parcel Administration >

Utilities L o : = = A0 Y D
Sales Analysis Utilities 3 Extract Sales Data From Master

Comp Snapshot Utilities » Apply Changes From Sales Into Master

Income Utilities » Sales Analysis Rate Table Utility

Mass Update »

Change Password

Extract Sales Data From Master — This option will allow you to copy Sales Data from the Master Database into the Sales
Analysis Database.

Apply Changes From Sales Into Master — This option will allow you to apply changes made in the Sales Analysis Database
into the Real Estate Database. Prior to using this utility you should contact Customer Support to ensure a valid back up file has
been created successfully.

Sales Analysis Rate Table Utility — Use this utility to copy tables between the Master database and the Sales database. This
will copy over the current valuation tables with the ones that you are copying.

Comp Snapshot Utilities - Choosing this menu option will open a sub-menu of the following sub-options related to the
extract and copying of data to or from the Comp Sales database.

File Cards i'uuiiuesl Help

A Job Queue ] EE i

fision 8 Appli| Recalc Parcels (.
Parced Parcel Administration »
Legal Infore Utilities »
Sales Analysis Utilities »
Comp Snapshot Utilities 3 . Extract Comps Snapshot From Master
Income Utilities » | Comps Snapshot Rate Table Utility
Mass Update »

Change Password

Extract Comps Snapshot From Master — This option will allow you to copy Comps Snapshot Data from the Master Database
into the Comps Snapshot Database.

Comps Snapshot Rate Table Utility — Use this utility to copy tables between the Master Database and the Sales Database.
This will copy over the current valuation tables with the ones that you are copying.

Income Utilities - Choosing this menu option will open a sub-menu of the following sub-options related to recalculating,
modifying and copying income data.
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[
|
|

@
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"bnw' Sales Analysis Utilities >
l Comp Snapshot Utilities >
l Income Utilities > ‘ Recalc Income Accounts
| Mass Update >l Clear Selected Accounts
FLETITI ¥ oo
PpINg
- -~ ‘ Copy Economic Adjustment To Actual
Classification & l;nd Informationg 1 ; T AR P K

Recalc Income Accounts — This utility will allow you to recalculate all your Income Accounts.

Clear Selected Accounts —~ This utility clears the selected Actual Income Accounts and Economic income Accounts on a mass
scale. You can select to only clear this years Selected Accounts or all Selected accounts.

Copy Economic Data To Current Year — This utility will allow you to copy your Economic Data to your current fiscal year.

Refresh Gross Rent Mapping — Use this utility after you have added additional Building Styles to the Styles Codes table that
do not appear in the Gross Rent Mapping table. After running this utility, these new codes will then show up in the Gross
Rent Mapping Table.

Copy Economic Adjustment To Actual — This utility will allow you to copy your Economic Adjustments to your Actual
Accounts.

Mass Update - Choosing this menu option will open a sub-menu of the following sub-options related to inserting data into
the database or updating certain fields in the database.

—
File Cards [_lJM] Help
% - Job Queue E
Vision 8 Applil  Recalc Parcels »
Parcel | Parcel Administration > |
Legat Inforr| Utilities v
' Sales Analysis Utilities > |
Comp Snapshot Utilities |
Income Utilities >
Mass Update » | Insert ’ '
|
| Change Password Update Fields 3 :
A 0

Insert — This option will allow you to mass update Notes, Notice History, Visit History and Overrides, and Adjustments by
opening the Mass Update dialog box.
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File Cards Help
RS  JobQuee ___ %= S o o
 Vision 8 I\.E.nhl Recalc Parcels »
Parcel Parcel Administration »
Legal In Utilities »
i Sales Analysis Utilities 3
Comp Snapshot Utilities >
Income Utilities »
Mass Update » Insert » i Notes
 ChengePassword | Updte Fields , Natice History
. =T | Visit History [
o l Overrides And Adjustments I|
Classification & Land Information®

Update Fields — This option allows you to perform Common Updates or Advanced Updates by opening the Mass Update
dialog box.

Ut I R -
ﬂ Job Queue .y ' EE s
|- - e — =yl =
Visioss & :\|.|-_.ni Recalc Parcels »
Parcel | Parcel Administration v
—_—é : .
Legal Inforn Utilities » ‘
: Sales Analysis Utilities ’ o
[ Comp Snapshot Utilities v |
I Income Utilities » )
el Mass Update ’ Insert »
| — — - e -
] Change Password Update lild_ds e’ b | Common Updates
: === IS |. —— ‘ Advance Updates

Change Password — Choosing this menu option will open the Change Password dialog box, which allows the currently logged
in user to change their password.

Change l C.fx-g_l
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You are here: Menus > Utilities Menu > Standard Building Permit Import Utility

OVISION

GOVERNMENT SOLUTIONS

Standard Building Permit Import Utility

The purpose of this document is to assist the user in running the Vision Standard Building Permit Import. This
Utility allows the user to import building permit records exported in the required format from an external data
source into the Vision CAMA system.

The document Standard Permit Import Specifications details the import file layout
requirements to be compatible with the Standard Building Permit Import utility as well as the
logic for required fields.

The specifications document should be shared with the resource responsible for the building
permit database to generate a compatible export file that can be consumed by the Vision
Import.

1. Select the file to be used in the permit import and place the file in the C:\Vision8\Imports on the
workstation from which the import will run.

. » ThisPC » OS(C:) » Vision8 » imports

$ & Marme Date modified
= [} Vision_BuiidingPermit_import 201902076 2:27/2019 11:12 AM
Persor

2. When ready to import the records contained in the source file, ensure all users are out of the
target database. Locked parcels may cause the import to fail. For assistance with checking if
there are any locked parcels please review the Unlock Parcels in the Admin Application
documentation.

3. The Standard Building Permit utility can be found in CAMA under Utilities > Utilities > Standard
Imports.
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Comp Snapshot Utilties ¢ | Change Unit Prices (S Ac, Ew) .
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| | Maks Al Fubure Parcels Active
Change Passwoed |
| Cear Betterments
| Cnar Betterments By Year |
. | ' Ouar Growth
| Save Assessment History
| | Masting Labeis l
an & Land Information® | Standard Extracts ..'
icing . | Standerd Imports »| | Building Permit Import
| Custom Extracts .
o " | Custom bmport v

4. Upon selection, the Building Permit Utility wilt appear.

| O BuildingPermitimpert a bet
|

iUnique Parcel Identifier: I REM_PID “|
| (] Validate data

5. Select the Unique Parcel Identifier that is included in the source file. In the below example
Account Number is the linking identifier listed in the source file.

Q) BuildingPermitimport - a X

Unique Parcel [dentifier. | REM_PID  ~ |
REM_PID
REM_ACCTNU,

—_— — REM_PIN

REM_ALT_PRCL_ID
REM_GIS_ID
REM_PRCL_ID

(] Validate data

6. Optionally, user may check Validate Data. Selecting this option will result in import rejection of
any record in the source file having a value in BPE_STATUS or BPE_TYPE that is not present in the
pick key assigned to the respective fields.
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© BuildingPermitimport = a X

Unique Parcel Identifier REM_ACCT N ~ |
[V] Validate data

B ] o

7. Once the import options are complete, the user may click Run to execute the import. If the user
is not ready and wishes to exit, select Cancel.

O BuildingPermitimport = a X
Unique Parcel Identifier: :_REM_ACCT_N il
Validate data

| Cancel

8. A message will appear after selecting run indicating the job is being processed. Click OK to close
this message.

This job will now run in a separate thread. For progress updates please
check the job gueue or PROGRESS table or the log files,

9. To review status of the permit import, open the Job Queue under the Utilities menu.

[ Utilities | Help
1..._____ e ——"

| Job Qu:.l»e

Recalc Parcels

Parcel Admini ion
Utilities

Sales Analysis Utilities
Comp Snapshot Utilities »

v ¥ T w

Income Utilities v

Mass Update 3

Change Password

10. Select Job Queue Type: Building Permit Import, then select the Job Progress tab, and click
Refresh. The current job will be displayed at the top and any historical jobs of this type run in the
database concerned will be displayed below. While running, the Status will indicate IN
PROGRESS, click Refresh until the Status is COMPLETE.
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11. After the import is complete, the log file can be accessed in C:\Vision8\Imports. This file can be
reviewed to ensure all records inserted successfully or to review errors for why specific records
were not inserted. For assistance understanding these logs or errors please contact Customer
Support.

ThsPC + OS(C:) » Visiond » Imports

- Mame Date M(l‘ff.eri Type Size
B Permitimport_error_log_43272019.6 LT/2015 V143 AM  Text Dacuenent 18
Permitimport_joblog 43272016 bt 2TIAAG 14T AM  Text Ducurment 1B
Permitimpart_error, mput.tt UANA A2 AM Text Document 1KB
Permitimport_error_log 42272019.6:t UAT/EN 114 AM  Test Document 1B
Permitimport_joblog 42272019t UMWY 1142 AM Test Document 1B
Permitimpert_log,tat 22772619 N2 AM Text Dacument 1kB
Pamitimport_joblog 32272019, txt LENHNG 1132 AM  Test Document 1 kB
Permimportd.tat LYHXN9 THIZAM Text Documem k8

12. Records inserted successfully are now available in CAMA on their respective parcels and building
records on the Building Permit Screen.
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You are here: Menus > Utilities Menu > Standard Permit Import Specifications

O VISION

GOVERNMENT SOLUTIONS

Standard Permit Import- Specifications

This document is created by Vision to provide clients file format details for Visions Standard Building Permit Import for Vision 8.

Format Requirements

Required File Type: .txt

Required Data Delimiter: Pipe

Required Text Qualifiers: Double quotation marks

File Headers: Headers are required in the first row of the text file

Date Field Format: MMDDYYYY

Business Logic for Import

Automation: None, user to execute manually
Frequency: as needed by client

Unique Parcel Identifier: At run-time, the user must enter the Vision field that matches the text file’s parcel unique identifier. The valid
options are:

REM_PID — Max length is 9 numbers

REM_ACCT_NUM — Max length allowed is 30 characters

REM_PIN — Max length allowed is 35 characters

REM_ALT_PRCL_ID — Max length allowed is 35 characters

REM_GIS_ID — Max length allowed is 30 characters

REM_PRCL_ID — Max length allowed is 20 characters

General Logic:
* The unique parcel identifier provided in text file must exist in Vision.
¢ A Building number must be provided in text file.

o If the building number in the text file does not exist for the subject unique parcel identifier in Vision the import will
insert the record on building 1.

Insert Logic: If the permit id provided in the import text file does not exist for that parcel and building number combination, then a new
row will be inserted into the BLDGPERM table.

Update Logic: If the permit id provided in the import text file does exist for the parcel and building number combination in Vision CAMA,
then the existing row in Vision will have all information updated in the BLDGPERM table from the text file.

User Audit logging: Records inserted or updated via import will be logged.

Specific Field Logic:
* BPE_FISCAL_YR is required and will default to the fiscal year set in Table Maintenance
* (REALCFG.REX_FISCAL_YR). if not provided in file.
* BPE_PLANS will defaulit to O if not provided in file.
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o BPE_SECOND_HALF will default to O if not provided in file.

Error Reporting and Verification:

o {f the unique parcel identifier is not found in Vision CAMA the record will be spooled to a log file.

* If a data element is having to many characters or is the wrong data type for a field the row will be excluded and spooled
to a log file.

o If a file with the same name has already been processed by the building permit tool, it will be rejected and spooled to a
log file.

e At run-time, the user will have an option to accept all data supplied in the text file into pick key fields or have the import
validate the data supplied in the text file against the pick key list defined for the BPE_STATUS and BPE_TYPE fields. if the
user chooses the validate the data in the text file against the pick key list in Vision and it is not in the list, the record will be
rejected and spooled to a log file.

User Actions after Import

Descriptions will require a parcel recalc with labels update checked to properly propagate the description from the configuration table.

Recommendations

File Name: Vision_BuildingPermit_Import_[date].txt

Example: Vision_BuildingPermit_Import_20180118.txt)

Import File Location: The text file for the import will need to be placed in the users C:\vision8\imports

Log File Location: The log for the import will be stored on the users C:\Vision8\logfiles

Examples

Import File: V8_Vision_BuildingPermit_Import_20180101.txt

Header Row:

ACCOUNT _NUMBER | BUILDING_NUMBER | BPE_PERMIT_ID|BPE_FISCAL_YR|BPE_APP_DATE | BPE_ISSUE_DATE | BPE_INSPECT_DATE |
BPE_TYPE|BPE_AMOUNT|BPE_FEE| BPE_APPLICANT | BPE_LICENCE |BPE_C OMPANY | BPE_AREA|BPE_REF |BPE_FLOORS|
BPE_PCT_COMPLETE|BPE_DATE_COMPLETE | BPE_COMM ENT|BPE_PLANS| BPE_SECOND_HALF|BPE_ADDED_AMOUNT |BPE_STATUS|
BPE_OCC_NUM |BPE_USRF LD_01|BPE_USRFLD_02 |BPE_USRFLD_03|BPE_USRFLD_04|BPE_USRFLD_05

Mapping

HEADER_POSITION

TABLE_SCHEMA

TABLE_NAME

FIELD_NAME

DATA_TYPE

DEFAULT_FIELD_LABE

TEXT_FORMAT_LENGTH

1 N/A IMPORT ACCOUNT_NUMBER |varchar(30) Depends on the unique
identification
field used

2 N/A IMPORT BUILDING_NUMBER  [humeric(9,0) Max length of 9
numbers

3 REAL_PROP BLDGPERM [BPE_PERMIT_ID varchar(20) |Permit # Max length of 20
numbers

4 REAL_PROP BLDGPERM [BPE_FISCAL_YR numeric(4,0)|Calendar Year Max length of 4
numbers

5 REAL_PROP BLDGPERM |[BPE_APP_DATE datetime2 |Application Date Must be MMDDYYYY
format

6 REAL_PROP BLDGPERM |BPE_ISSUE_DATE datetime2 |Issue Date Must be MMDDYYYY
format

7 REAL_PROP BLDGPERM [BPE_INSPECT_DATE |datetime2 |Inspection Date Must be MMDDYYYY
format

8 REAL_PROP BLDGPERM [BPE_TYPE varchar(6) |Permit Type Max length of 6
characters
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HEADER_POSITION|TABLE_SCHEMA|TABLE_NAME FIELD_NAME DATA_TYPE [DEFAULT_FIELD_LABEL] TEXT_FORMAT_LENGTH

9 REAL_PROP BLDGPERM |[BPE_AMOUNT numeric(9,0)|Cost Estimate Max length of 9
numbers

10 REAL_PROP BLDGPERM |BPE_FEE numeric(9,0)|Fee Max length of 9
numbers

11 REAL_PROP BLDGPERM  [BPE_APPLICANT varchar(50) |Applicant Max length of 50
numbers

12 REAL_PROP BLDGPERM  |BPE_LICENCE varchar(20) |License Max length of 20
numbers

13 REAL_PROP BLDGPERM  |[BPE_COMPANY varchar(50) |Company Max length of 50
numbers

14 REAL_PROP BLDGPERM  [BPE_AREA varchar(20) [Square Footage Max length of 20
numbers

15 REAL_PROP BLDGPERM  |BPE_REF varchar(20) |Field Number Max length of 20
numbers

16 REAL_PROP BLDGPERM |BPE_FLOORS numeric(5,2)|Floors Max length of

17 REAL_PROP BLDGPERM  |BPE_PCT_COMPLETE |numeric(9,0)|Percent Complete Max length of 9
numbers

18 REAL_PROP BLDGPERM  |BPE_DATE_COMPLETE |datetime2 |Completion Date Must be MMDDYYYY
format

19 REAL_PROP BLDGPERM  |BPE_COMMENT varchar{750)|Comments Max length of 750
characters

20 REAL_PROP BLDGPERM  |BPE_PLANS numeric(1,0)[Plans Check box 1 for Yes O for
No

21 REAL_PROP BLDGPERM  |BPE_SECOND_HALF  |numeric(1,0)|Second Half Check box 1 for Yes O for
No

22 REAL_PROP BLDGPERM |BPE_ADDED_AMOUNT|numeric(9,0)[Total Value Max length of 9
numbers

23 REAL_PROP BLDGPERM |BPE_STATUS varchar(6) [Status Max length of 6
characters

24 REAL_PROP BLDGPERM |BPE_OCC_NUM varchar{25) [0CC Max length of 25
characters

25 REAL_PROP BLDGPERM [BPE_USRFLD 01 varchar(100)|User Field 01 Max length of 100
characters

26 REAL_PROP BLDGPERM  [BPE_USRFLD_02 varchar(100)|User Field 02 Max length of 100
characters

27 REAL_PROP BLDGPERM  |BPE_USRFLD_03 varchar{100)|User Field 03 Max length of 100
characters

28 REAL_PROP BLDGPERM [BPE_USRFLD_04 varchar(100) |User Field 04 Max length of 100
characters

29 REAL_PROP BLDGPERM  [BPE_USRFLD_05 varchar(100) |User Field 05 Max length of 100
characters

Disclaimer

Vision reserves the right to modify these specifications at any time, please contact Vision for the latest version.

Any client requested modifications are subject to a billable fee determined by scope of work. Scope of work must be defined between
Vision and client, an estimation quoted by Vision, and must be approved by the client prior to the start of work. Completion of work is
determined by Vision’s work prioritization.

2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Menus > Help Menu

OVISION

GOVERNMENT SOLUTIONS

Help Menu

This document will walk the user through the options under the Help menu heading of Vision 8.

Clicking the Help menu heading will open the options available within.

—

3

WVision B A pplicat

Parcel

Help menu items include:

Contents — Displays the introduction page for the Vision online help system with a contents
navigation panel on the left.

About - Displays the Vision 8 software version number and copyright.

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Parcel Maintenance > Data Entry F.A.Q,

OVISION

GOVERNMENT SOLUTIONS

Data Entry F.A.Q.

This document contains solutions to several commonly-asked questions regarding the Vision 8 software.

1. Question: Where do | find the Legal Description?

Answer: Click on Legal Information, Supplemental Data from the Navigation Tree on the left to
open the Supplemental Data screen.

Refer to the Parcel Description field.
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2. Question: Where can | put property notes?

Answer: Click on Legal Information, Property Notes from the Navigation Tree on the left to open
the Property Notes screen.

Note: Check the Private Notes box to exclude entered notes from being included on the Property
Record Card.
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3. Question: How can | tell exactly how the building or land is being valued?

Answer: Print a Cost Report and/or a Land Report:

Click on Utilities, Recalc Parcels, Recalc Reports, Cost Report/Land Report.

Job Queue [,p l Lﬂ a -;' g Value Freeze On

j Recalc Parcels ' Recaic Current Parcd )

| Parcel Administration | e 100V Use Ty
Utilities v Recalc Select Parcels Parc $8.600 Llnd &
Sales Analysis Utilities » | Recalc Reports » Cont Report
Comp Snapshot Utilities

. T_Yea_r Note Privat
*» JFNOTES 2014 mmom Land Repo

» F_ NOTES 2014  2006:DESC CHGD

Mass Update

Change Password
—p—

|
|
\ Income Utitilites
|
|
|

4. Question: How do | make a vacant parcel an improved parcel?

Answer: The Land Use Codes drive the parcel classification/use — vacant or improved, commercial
or residential, etc.

a. Click on Classification and Land Information from the Navigation Tree on
the left to open the Parcel Information for Land screen.

b. Click on Edit Lines.
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¢. Click on the Land Use Code drop down arrow to select a code designated for
improved parcels. Typically Land Use Codes that end in R will be for
Residential, C for Commercial, and V for Vacant.

# Land Detein

f bog ¢ Lre®

frorp 200C: $FD - Suburban - Comm
e 200: SFD - Suburban - Exempt

d. Once the Land Use Code is entered, you will then need to enter data on the

Construction Detail, Depreciation and Sketch screens — all 3 of these screen
selections are found on the Navigation Tree.

5. Question: How do | make an improved parcel a vacant parcel?

Answer: The Land Use Codes drive the parcel classification/use — vacant or improved, commercial
or residential, etc.

a. Click on Classification and Land Information from the Navigation Tree on
the left to open the Parcel Information for Land screen.
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b. Click on Edit Lines.
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c. Click on the Land Use Code drop down arrow to select a Use Code
designated for vacant parcels. Typically Land Use Codes that end in R will be
for Residential, C for Commercial, and V for Vacant.
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d. Once the Land Use Code is entered, you will then need to enter the style
code on Construction Detail screen, selected from the Navigation Tree.

6. Question: How do | do parcel splits or create a subdivision?

Answer: Click on Utilities, Parcel Administration, Create Vacant Parcels.
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For additional instruction, please see separate documentation.

7. Question: How do | copy parcel data from one parcel to another parcel(s)?

Answer: Click on Utilities, Parcel Administration, Copy Parcels.

(] wet

|

Recair Pasoek

Porcyt Admnatrasan » Cramie Vacand Pumely
Unhiog >
Satgr Analyss Uniites )
Comgp: Srapybot Utilithes »
racove Likities »
W, Lpdew "
Chengs Paveword

o Queve r pwald &,

Capy Paro
hicve

For additional instruction, please see separate documentation.

8. Question: How do | move a building from one parcel to another parcel?

Answer: Click on Utilities, Parcel Administration, Move Building.
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For additional instruction, please see separate documentation.
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9. Question: How do | transfer a parcel to a different Owner (add a new Owner)?

Answer: Click on Owner and Deed from the Navigation Tree on the left to open the Owner and

Deed screen.

a. Click on Add Sale.
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| Parcet intersmatron
- Paecel O4L000/ 0001/ ONSO0LS D000/  Actount Numben
!!-Ch: Owmery Name: JOHN SMITH
tnserral Dy tn Locabion: 2380 Any
:,. |Book Fage Date of Veanater QU VacAmp Gabe Price W0 Record Date Relecesce Numbes
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At Saln Dwite S [Vomm e P of oo 1
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& Cic Risige O
Anytown, UE 01234
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- |lios
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OR

b. Enter any length of characters in the Owner Name box and click on Search

to see if the owner is already a property owner
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a. Enter the exact owner name in the Owner Name box and click on Create

New Owner to create a brand new owner name.

Owner Search Criteria

|  Owner Name Co-Ownar Name Ownar Account

Croate New Owner

10. Question: How do | change a mailing address?

Answer: Click on Owner and Deed from the Navigation Tree on the left to open the Owner and
Deed screen.

D

a. Click on the Owner name entry line.

b. Click on Edit.

| v sy ~— - Lo () - o=
- e

| T T ot et e W Lo e

¢. Click on Update Address.

et 1 Sy £u-Ooarwrs bl e bylrns Lot |

- e ] AL W LT S e G5

g e LGt AR gt et (W el (han eheted Ry ity

ot

11. Question: How do | remove a building override value?

[ .

Answer: Click on Building Information, Depreciation from the Navigation Tree on the left to open
the Depreciation screen.
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A. Remove the Appraised Override Value and the Assessed Override Value
amounts by clicking in each of the boxes and using the Backspace key on the
keyboard, clearing the contents.

B.Remove the Override ID by clicking in the box then clicking the Delete key on the keyboard.
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Pt Cace AR R e 5
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Qompdy| mwr ]
Curriin Vile
Wk Trpe Tomba Goly  Dwie o © —

}'m

s ipeoes

8 b v
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12. Question: How do | remove a land override value?

Answer: Click on Classification and Land Information from the Navigation Tree on the left to open
the Classification and Land Information screen.

a. Click on Edit Lines.

Oulifng Clums Secator atd Lond Lne Visha tsy

Bge red Code  Demepbon ot e depones fea— ;:““ Zme 2wt
[T i W Smge feniy A . M e LAY aEE - e Lnn
e hows o s o pos— mamo D i v
Mo e

ne Sy famdy 1w &

b. Uncheck the Override Assessed Land Value box and the Override Appraised
Land Value box.
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U

995 Condo Main .

District

Frontage 36

Depth

Laewd Units
Unit Type

11255
21146000

Special Caks
Notes

Adjustments (Special

[ Override Appraised Land Ve

B Override Assessed Land Vakus

Totals

{?:S-quare&« .

ot Type
Unit Price @15
1and Type Adj 0 100000000

Land Type Site | P Prima ~

Apprased 887500.00

i

13. Question: How do | unfreeze a parcel?

¥ ‘
Assessed 887500.00
Cose. |

Answer: Click on Legal Information, Account Information from the Navigation Tree on the left to
open the Account Information screen and check the Value Unfrozen check box.

a. Find the check box labeled “Value Unfrozen” or similarly named.

b. Click your mouse in the check box to add a check.

c. The proposed amount column will be removed and you will now only see one

Amount column.
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ARRID 000010020305
Cross Street 1

Cross Street 2
[¥iValue Unfrozen
Assessing Neig
Res Nbhd
District Code
Current Assessment :
|Code ! Description
100 Building
100 Land
100 Qutbldg
Total Assessed Parcel Value

[ Type
Building
Land
QOutbidg

Amount

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com

Equal Opportunity Employeer/Affirmative Action Employer

$251,500
$63,700
$5,400

$420,600
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You are here: Parcel Maintenance > Basic Process > How to Add a New Parcel

OVISION

GOVERNMENT SOLUTIONS

How to Add a New Parcel

The purpose of this document is to assist the user in filling out all required information for creating a new
parcel.

1. Log into the Appraisal Vision Application. Once the application is loaded click on the Add New

Parcel button in the top left hand corner of the screen.

File Cards Utilites Help

o) * M = TW

plication Explorer v i :x] |

«|
)

Parcel

2. In the New Parcel window, enter the MBLU, Account Number, Property Location, and City, State,
Zip.

¢ Both the MBLU and the Account Number must be unique from those used on other
parcels.

¢ |f your municipality does not use Account Numbers, fill in the MBLU value in this
field as well.

3. Enter the Primary Use Code for the new parcel in the Prim Bldg Use field. Remember, because label
localization options allow fields to be renamed, this field, and others, may have different names (e.g.
“Primary Use” instead of “Prim Bldg Use”).

You can enter the code in two ways:
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» Type the Code in the Prim Bldg Use field

s Use the pick list to select from existing Land Use codes in the database. This can be
accessed either by clicking the drop down arrow on the Prim Bldg Use field or by
clicking the Prim Bldg Use field and hitting the F6 key.

102

Account Numbes | 100506002

Property Location !

Chty, State, Zip: ANYTOWN SMA E:m-'f
Primary Use 100R SFD - Urban Res v | Legal Area | Associated Parcel

Assessing Nesghborhoods:
Res Nbhd

4. Enter the Legal Area of the parcel in square feet.

Legal Information
MBLU

Property Location ' | MAIN ST

Chy, Stave, Zip: | ANYTOWN  IMA 00007

Pimiony Use | 100R: SFD - Urban Res ¥ | Logal Area (43560 | Associated Parcet

Assessing Neighborhoods:
Res Nbhd

5. Enter the Assessing Neighborhood for Res. NBHD, Comm. NBHD, and Condo NBHD

You can enter the Assessing Neighborhood codes in two ways:
¢ Type the code into the Assessing Neighborhood fields.

e Use the pick list to select from existing Assessing Neighborhood codes
in the database. This can be accessed either by clicking the drop down
arrow on the Assessing Neighborhood field or by clicking the Assessing
Neighborhood field and hitting the F6 key.
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—a

0001: Default Dist: v Comm Nbhd 0001; De-fault Dist w! Condo Nbhd 0001 Defm-ﬂ 'Dim v

102

100506002

A

ANYTOWN (MA 01234

Primary Use 100R SFD - Urban Res ¥ LagatAren 43560 Associated Parcet

Assessing Nesghborhoods:
Res Nohd 0001: Defautt Dists v Comm NShd | 0001: Default Dist w| Condo Nbhd ' 0001: Default Dist v

After clicking OK, the Account Information screen opens.

Accowst ifecTnamen

T4 + n | fom b Parcsl RS i, i trw *
Acowst Numbme ' XN00) weg |} e Ouipping Croste Owe  10r137004
Ut o type -
Praperty Locston | a7 M i WemAme g
Coy Gty Jap  ANVIOWN LR Primesy Use  jo0q 5113 - Lt Res -l
Sate Cevenny b L TR LT
B ik
Subseg Neme _ | Vined
i HSB002
oot Tirwen 1
Cross Svees?
L} Vanve \inirtaten
s e e
L L] 100N (wlmm W Comem Nohg OO0 [ttt @ ol iibeg M1 et v
Owiricr Coge i v e Cote -,
Clrvpst Asmmmuriont oy
Lot ol e Typ= ot Bropoeed) vl Parcet
Dascrpmion
Comrpy i
Tats! Amawwd Pareet Vatee 9 Assocend Pumw © | AsDcistng Pescom
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The following fields are optional and not required. If information is
being tracked in these fields, enter the data on the Account

Information screen.

e W-B-P(Ward-Precinct-Block)
e Cross Street 1 and Cross Street 2

¢ PIN

e AltID

7. Select Owner and Deed from the Legal Information sub menu, located in the navigation tree on the

left hand side of the screen.

The Owner and Deed screen opens after being selected.

Lesgad
[ - e [ Sy

e

At e

[

Pyt iy L T
S Ot
S Type
Lale e
L2

ki, Vit

8. To add a new sale to this parcel, click the Add Sale button.

Parcel

" Legal Information

Account Information
OwnerAnd Deed _‘i
Assessment History

Other Assessments

Exemptions

Fgreat s Bacetobon:
Supplemental Data
Abatements
Assessment Change
Parcet Addresses
Associated Parcels
Natice History
Property Notes

Parcel Audit

_Sub Division History . ...

Date o

b —r

g e

M Dy
Vom  cmgarie |
o
Vet Tource

At garr (i T
Mot b a)

R =

Coabg

T
Liew

Fagtacs ong  Ciwgty Comg: Sragros
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Y

|
] Owner Full Name
i ’

|
IFC 7
€ owner .
4
kel o . |
: 4
|Delete SaleﬂView Owner(S}":l !
/
— - - = S S S T i l_ __‘:l
Owners: | El[ Edity

T e L A 8

9. Enter the Owner Name, then click the Search button or press Enter.

Co-Owner Name Owner Account

| ) Sewen
Saafenit I‘CMM @

10. The Owner Search Criteria screen will appear. If the owner is already in the municipality’s database,
select the owner from the search results, then click the Select button or press the Enter key on the
keyboard.

Qwner Name Co-Ownes Mame Owener Account
Search|
Select Create New Owner
Owner Full Name Co-Owner Full Name Address Line 1 City State g
W e - om S B L .
P OIOSEPHUONES o o ST Main St - Anytown: A - 00000-0000 ’
JOSEPH JONES 2 Main St Anytown MA  00000-0000 '
JOSEPH JONES 3 Main &1 Anytown MA 00000-0000
JOSEPH JONES 4 Main 5% Anytowm WA 00000-000%
JOSEPH JONES 5 Main 52 Anytown MA D0000-0000

JOSEPH JONES b Mair 5¢ Anytown MA 00D00-D00D

-y g . J— -

11. If the owner does not currently exist in the database, click Create New Owner.

Qwner Account

—

C
l ' @a Search
Ownet Ful Name | Co-Owner Full Name ‘Address Line | Clty  State | Zip
B A - A . A . L A [
o R S i Pl e TS WA gl B TR iz =

me
-

S

12. Add the Owner, Co-Owners’ full name, and any other tracked information if applicable, then click the
OK button.
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s =t
Furit Nara Last Namme Miaw
Owrae Dm0 frens ' | e
Co-Ownt vl Miomm [ e Bt b
1. Agaw Somw

(eney Aowess Aosen Lre |

| AN 5T
Ciny Sane e
ANYTONN A Mg w23

13. Enter the Sale information, including Date of Sale, Sale Type, Sale Price, Book, Page and Validity
Code.

Primary Sale Information ’

Sale Date | 10/20/2014 ml

Sale Type [A: Family Sates [El
Sale Price 250000

 o—

 —

—

Book 504 ) —
' | —

| e—

Page 23
Validity Code 0L VAUDSMLE v
(] Qualified? [ improved [ | Future

i
. — R 4
A x r. z o (i - O L T R e

You can enter the Sale Type and Validity Code in two ways:
¢ Type the code into the field.

¢ Use the pick list to select from existing code in the database. This can be
accessed either by clicking the drop down arrow on the field or by
clicking the field and hitting the F6 key.

&x The Validity Code determines if the sale is Qualified or Unqualified.

You will now see the new Owner on the top line as well as the owner’s mailing
address in the bottom section.
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Legal ;
FC > Owner Full Name ook | Page -
» G Y - mm T S L g — b & L »m - a - (I
{Add Sale <iete Sk :]jﬂ_!wml[ Number of Qwners: 1] r!r
r
Owners: | 10HN S SMITH v fear
Owner Information Y
Owner JOHM S SMITH ,
JOHN 5 SMITH {
1 MAIN ST 5
ANYTOWN, MA (1234 /
Primary Sefe Information . . gy
Note: Each Sale Line has a designated field for deed notes. This is not a
required field. This space is available for special notes pertaining to the sale.
Primary Sale Information :
<
Sale Date | 10/20/2014 3| ;
5 F ;
Sale Type | A: Family Sales b 4
Sale Price | 250000 1
Book |504
Validity Code | 01: VALID SALE v s
Qualified? [] improved [ | Future
'Original owner _ /
! L—
Notes ;
.
/
e s e A A R S e s e L = o f

14. Next, the Value Source for the parcel should entered. Select Assessment History from the Legal
Information sub menu, located in the navigation tree on the left hand side of the screen.
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Parcel

Exemptions

Abatements

Motice History

Parcel Audit

Legal Information R
Account Information
Owner And Deed

Assessment History :C)

Other Assessments

Arvomzed Eeemohions

Supplemental Data
Assessment Change
Parcel Addresses
Associated Parcels
Property Notes (3)

~-SubDivisiopMistory ... , .. .

sy g i o 4

F R G G UL N T eSS Nty wgs)

The Assessment History screen will open.

AR P Seutmmary
Velee  Dote Suates | S Vialsa Apprmses A
Erpvnae ® Tetal Bullting Vol
e Comp Sae » Totul Daw Fastuire Valor
Camg Appertiassen Total Cuttsindeny vt
oty Apgerticor=ent » Total Land Vislue
ncome L} Total Value
Can 00580 A (4
Troret o)
Ve Samace OCm b
Astpvireeen Ratve 1080 Peimary Ve o
= & Ve Ty Resson Cade Dpte ekl 8 Comment
Overdile | . I
P ] e ———— —
Agartimest ety

Agyersrrerd Dezain
fignese Eres, Orer s

Duddng Valup  AF Vadue

Ousmashoug Vi engrovd Valee *Landl Vialoe

R

‘Eimgune  Sowts Come -

15. Enter a valid Value Source. Value Source dictates the Valuation Approach to Value the Parcel.

You can enter the Value Source code in two ways:

e Type the code in the Value Source field

e Use the pick list to select from existing codes in the database. This can

be accessed either by clicking the drop down arrow on the Value Source
field or by clicking the Value Source field and hit the F6 key.

166



Assessment Sommasy

Regression
Market Comp Sales

Value
$0
$0

Total Apportionment 0
o

500

$0

Overtide | oot

Rty iowe
Assessment History . ) .
Num Year (VF Dme  [Class Use |Bullding Value K,

16. Next, the Classification and Land Information data for the parcel needs to be populated. Select
Classification & Land Information from Classification & Land Information sub menu, located in the
navigation tree on the left hand side of the screen.

Classification & Land Information? |

&1 Land Information A

.

{

/

H

Conco PMan bigineris 4
Assoraled Lo o |
Extra Features i
Building Permits :
Fires }
Visit History :

s Bitimp Motas. . e T A

The Classification and Land screen will open.

Propsrty Facson
Ly - iy gt - -unn; - Tope -
[T o Dreet ¥ Foobewy b Sl Type -
[EE " Strees = laemen e Lo gy -

Land Vahaston Neghiomeods -~ ~  lctfees — "

L1 Sub hetd A X [ -} fromtage O Bepmn o Goimc .
Qe NRleg 007 t Buty oy [ Piamet N S Prossagn © l-—-te”_f iy Pt 9 '
T Comipnsr Ny Tromtage O ot Type 1!;’
Busdvimg Charsfh afen Ared Land Line Wesatn
[T T S— v e fo—— Soeoemt 210 (1 lanc Type Duse
L | L1 1008 W0 - Uvian Fes o AASED SF + S o
oty

17. Property Factors section fields are not required. If information is being tracked in these fields, enter
here.
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Any Property Factor Fields not being used can be suppressed in the Admin Module.

PropaTy Facton !
Untien L el w008 Ptam - Tope -
nsthes » reet ¥ Mesdwy L, S0l Type %
Uity e Street ¥ Eammont ” Lecation -

18. The Land Valuation Neighborhoods section contains fields that populate Sub NBHD’s, GIS Region,
Pocket NBHD, and Z Contour if applicable. These fields may not be required.

Land Valuation Neighborhoods APy .
Res Nbhd 000 Sub Nbhd| A v GisRegionnm. v
Comm Nbhd | 0001 Sub Nbhd 4 Pocket Nbhd
Z Contour
PN P T P e e i g =D wl s T T T Va5 =

19. The Lot Factors section contains fields that can be populated for informational purposes but they are
not required fields and have no impact on value.

-

Lot Factors y:
Frontage 0 | Depth 0 Gis Area |0 g
’ ;
SecFrontage 0 |  Perimeter 0 Gis Perimeter |0
Num Frontage 0 | Lot Type} R ;
- I e e T ad ,'f"é"‘-_;./‘“""“»;’ ,J’o__)ll'_-'_'_;_'-""‘""’_)"’J""’J.‘ —rer, S
20. Click on Edit Lines button.
Bullding Classification And Landg Lin= Valjation
Bidg# Unes Code | Uewngtion Units ”;:::‘ Appraised Agsesieg s:::_‘m Zone I:: Lana Type Desc
[ 1 WOR  SFD - Urban Res 43580 & 0m 000
Lang Acres ¥ Apprased $0.00 | it ines
ticc Line
00R S5O - Urban Res 1w R
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21. This will open the Land Detail Information for the parcel. Required Fields are marked by a red
border and exclamation mark.

v ———— T P e . TN emm———

i"é Available Use Code, Zoning, and District items are entered in Table Maintenance or the
Admin Module. See their respective sections for adding new codes.

To enter a specific unit price, set the Site Index to 0

Bdg®  Line® ¢

1 2 steindex 0 w|
Use Coder 100R: SED - UrbanRe ¥ Land Type | . 1
Zookng ZA: ZONE A ¥ uUnaprice 256 \ S— @ ]
District D1: DISTRICT 1 ¥ Influence Factor |! '
Frontage Condition Facto | !
Depth Nbhd 12 ‘
Units 2500 Nbhd Ad) ;
Linit Type SF: Square Feet ~  Size Adjust !

“u g

22. When you have finished filling out the information for the new land line, click Close at the bottom of
the Land Details screen.
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Totals ;
Appraised 6400 Assessed 6400 *

[ Net | | Add | [ Delete | [ GCose

?

}

B P e o s B oL Sl I S L Al e SN

23. Next, the building information needs to be entered for this parce!. Select Construction Details from
the Building Information sub menu, located in the navigation tree on the left hand side of the

screen.
Building Information &/

" (Construction Details ' ¢
Depreciation ;"
Londen Mg Tt ,J
LUUS, L el S
Extra Features f
Building Permits }
Fires e
Visit History 4
Building Notes ¥
Photos ¢
Sketch 5
R L

24. The Construction Details screen will open. Required fields will be marked with a red border and
exclamation point. Fill out all relevant fields.

‘namgs (ol MITl l0) o il lsmsen ol imifal lalm

[ 0 Resmenig w Putlype? | i, Nememes Gomge .
Style < L Ty -
[ = L T =
s = S
fosdatan Tigo ' w  Tomt Aessw
Fonndabun type i w Fulllats
Eemomcr Wad 1 o [Futiath Grage -
[ v Wl
[ T - Wl Gom Sine v
Oupsll Cumn - OOFuhae
Hioot Bt 1 v G fimoe Gma. -
Paod €oowes 1 ) ¥} . L
AmdCome? | o Bk o *
friicronas | o Feuow
paa——_ — f:.z‘m
ot (T e tye =
e e

b2 l-ﬂh
ke

You can enter the Construction Details information in two ways:

» Type the code or value in the appropriate field.

¢ Use the pick list to select from existing codes in the database. This can
be accessed either by clicking the drop down arrow on the field
concerned or by clicking the field and hit the F6 key.
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Model [01: Residential w FoelType ¥
Stybe [v]@Fuel Type i
Grade 10: SF Dwelling w - :
Stories 11 Mobdehome
| 12 Muiti-Famity
Type * 13; Office :
Foundation Type | 15; fectsuram
Exterior Wall 16: Retast Gy
£ Wat 2 17; Se@ilt
18 Townhouse @
Overall Cndtn | 20 Warehouse Fomer
Py 5 21: Quadplex qur
94: Vacant W/Outbuildings :
Roof Cover 1 | 99: vacant Land :
Roof Cover 2 ) !
interior Wall 1 . 1
Interior Wall 2 s o,
Fireplace O;
intenior Flnar ¢ - [

25. Next, depreciation information needs to be entered for this parcel. Select Depreciation from the
Building Information sub menu, located in the navigation tree on the left hand side of the screen.

Building Information

Constra-ction Details

{ fain Elemonts

Ancoriated Cordoz
Extra Features
Buiiding Permits
Fires

Visit History
Building Notes
Photos

Sketch

s T e

After selecting the Depreciation sub-menu, the Depreciation screen opens.

(bicmg e o v lalw o |s-mnli=-;$_ lﬁld

Degrecation fie b
Lechon Level Deprecaton
e IO E——" Sasen tamiry
ectne Vo St 518 Tlovwibe Orowp e~ Ettecsney Ao 788
iy Mimetne §1 ey
L= 1) Tean
Congm Ioat Ot Acf] 5200 acmp Bt o0
Uy Apes 000
Percent Complete Comm Ducgtion Grows Lng B dems, i
8T tribees X% MB2 2052
h -
SR Auee F YN w3
Yamt Rerrocea Crrermge inmaly “
Cveriate Ve
Wk Tywe fessonCade  Dete ___|Il Commimant

~r o) ; — =

el I._.___:ﬁl

] | —
(Com Yo Cure| .- { [

Chverutp dgypraned Wi Aissuen Qe O _l_j

26. Enter the Year Built and the Depreciation Code.

£l ¢
‘
!

7

Sasa

“w(-‘\u*“\-..\v. LA R WL W

|
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Depreciation Title
Section Level Depreciation

Year Built 12005 :
Effective Year Built 2007 Ovr EYB

. TP

Functional Obsol ;
Economic Obsol | 1
Condition ;' v ;
Percent Complete | ) (i
Depreciation Code | G: Good Em /’j
Remodel Rating | ™ 7
Year Remodeled Override Initials f
Override Value | ) {’
SIS T T o S o

You can enter the Depreciation Code in two ways:
¢ Type the code or value in the Depreciation Code field.
¢ Use the pick list to select from existing codes in the database. This can

be accessed either by clicking the drop down arrow on the Depreciation
Code field or by clicking the field and hit the F6 key.

iﬁ“é If the parcel is under construction, enter the Status and Percent Complete.

Depreciation Title ;
Section Level Depreciation p
Year Buiit 2005 ' 1
Effective Year Built 2007 '[] owEYB f
Functional Obsol j
Economic Obsol :
Condition |UC: Under Consti| ¥ i
Percent Complete g5 |<: :
Depreciation Code ': G: Good (3 b
RemodelRating | (v !
Year Remodeled | Override Initials
Override Value '. )

#
et gt NSO, e RS

27. A Sketch needs to be added to the parcel if it has a building to provide gross, living, and effective
area values. Select Sketch from the Building Information sub menu, located in the tree on the left
hand side of the screen.
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Building Information A
Construction Details
Depreaation
Condo Main Flements
Assacated Condos

R e~ R ey e da P

Extra Features

Building Permits

Fires ;
Visit History 1
Building Notes i
Photos :

Sketch y

M‘.’.‘W"'W T a":

28. Enter your Sketch. See Sketching Instructions for directions for adding sketches to a parcel.

P anie ESlL fro¥rex __
—‘J W 0 B [ I " » " "0 1o e 36 (] w isa
ssssbiissbisssbossilinsslinsidessetonanlionid | Saviadiisat ! £ i : SRS TR (FFOURE RN IR PO JOSTON Ty SRPE SRGY SRSPUT PO Foonet 30,

| i
;m-f
oo '

3 18T

E ZM i
T 608 =

3 (2,052 o)

: wDK ai
a0 (1,176 o1
b0
L3 L]
ISacn. Co. Descrigtion Gross Atea  Effective . Living Ac,
] 15T tol Meoar 2082 1082 e
1 258 5% Artic iewed 20N 50 s
) G40 660 Savemert Un.. 2082 108 o
1 W.. Wood Dt L% 176 1]

pann e psm
i M dncles “: L0 I - B 1Y
29. Once the Sketch is complete, click on the save changesicon * " or press the F2 key to save your
changes.

File Cards Utilities Help

# CLalliy|

Vision 8 A tion Explores v 0 x

|
Parcel * 1

If you pressed the F2 key, Vision will ask if you want to save changes. Click Yes.
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o Save changes to data?

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Parcel Maintenance > Basic Process > How to Add a Second Building to a Parcel

OVISION

GOVERNMENT SOLUTIONS

How to Add a Second Building to a
Parcel

The purpose of this document is to assist the user in adding an additional building to a parcel, including
completing all required fields

1. loginto the Appraisal Vision Application. Once the application is loaded search for the parcel to
which the new building will be added.

2. Once on the selected parcel, click Construction Detail from the Building Information sub menu,
located in the navigation tree on the left hand side of the screen.

Building Information R
Construction Details ;
Depreciation 5

]
f‘
Extra Features ¥

Building Permits

Fires /(
Visit History /l
Building Notes (3} {
Photos J
Sketch i
Outbuildings t
Outbuildings ;

O T ol e P

A
LN

R o S -

3. This will open the Construction Detail Screen. This screen will appear different depending on what

model {Residential, Commercial, Condo, or Condo Main) the parcel is or the fields your jurisdiction
enabled.
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4. Click on Add New Building _E] button at the top right hand corner of the screen.

This will open a Land Use Codes screen,

Buiding #: | @ [%] (0] 1 [0] of 1/
ﬂ Baseme ::f;‘
’
]/r’ar,_,_,....wm,-,_w__f-ﬂ,wuv' __,_,,,-,,,_J,,J,:

T30l D =301 A S
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Filter by Land Class
R: Residential v [] Mixed-Use
iCode. <. | Dascriptive
000 No Data
100E SFD - Urban Exempt
100R  SFD - Urban Res
SFD - Urban MH
SFD - Urban Condo
SFD - Urban Vacant
SFD - Suburban - Exempt
SFD - Suburban - Farm
SFD - Suburban
SFD - Suburban - MH
SFD - Suburban - Condo
SFD - Suburban - Vac
Dwelling - Multi - Exemnpt
Dweliing - Multi Fam
Dwelling - Multi - Condo

. Ok [ Concel ]

5. Choose the Land Use Code for the Building and then click OK.
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Filter by Land Class

R Residentisd  ~ [ ] Mixed-Use
Code ~ | Description
000 No Data
100E SED - Urban Exemnpt

» 100R: —ISFD~ Urhan Res
1007 SED - Urban M
100 SED - Urban Condo
100V SFD - Urban Vacant
200k SFD - Suburban - Exempt
200F SED - Suburban - Farm
2008 SED - Suburban

2007 SED - Subutban - Mk

200U SED - Suburban - Condo

200V SED - Suburban - Vac
Dwelling - Multi - Exempt
Dwellirg - Multi Fam
Dwelling - Multr - Conde

|

The application will open the Construction Detail Screen for the added Building.
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6. Fillin the required fields, marked with a red outline and exclamation mark. Required fields can be
set in the Admin Application and are different for each jurisdiction; however Style, Model, and
Grade are required for the basic functions of Vision.
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The building number is located in the upper right hand corner. Use the arrows
to switch between buildings.

Buiding #: || [%] [(0] [ 2|[G)] o 2|r
3; Basement Garage || f v
= I T EEEs IJ
'-]!" _.__J"’",E‘TJ»I" - I N S Y S _A"

7. Select Depreciation from the Building Information sub menu, located in the navigation tree on the
left hand side of the screen.

- ﬂ..u-! '_"\.‘I

‘Building Information 2 |4
Construction Details \"
Depreciation ;
Extra Features
Building Permits ¢
Fires ;
Visit History ]
Building Notes 0
Photos

S

Lsketch e e

8. The Depreciation screen will open.
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9. Enter Year Built and Depreciation Code.

Depreciation Title

Section Level Depreciation f
Year Buift 2010 z’
Effective Year Buiit 2010 1 Ovr EYB l
Functional Obsol ,
Economic Obsol :
Condition | |vl :
Percent Complete T
Depreciation Code | A: Average ;
Remodel Rating ' ;
Year Remodeled | Override Initials
Override Value ' ) :

Value Type Reason ij
W8 s <= | Pem—" ey Lo SO s D

You can enter the Depreciation Code in two ways:

¢ Type the code or value in the Depreciation Code field.

* Use the pick list to select from existing codes in the database. This can
be accessed either by clicking the drop down arrow on the Depreciation
Code field or by clicking the field and hit the F6 key.

If the building is under construction, enter the code in Condition {commonly
labeled Status) and enter a Percent Complete.
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Depreciation Title
Section Level Depreciation

Year Built 12010

. Effective Year Built 2010 (m] Ovr EYB
Functional Obsol n
Economic Obsol | |

Condition i UC: Under Consti Fm
' PercentComplete  [g5 _m

Depreciation Code é"ﬁ_ﬁveég_e . [!_JI'

R W T W T S L L SNEPUR, VSIS I e

Remodel Rating | EJI
Year Remodeled ‘ ' Override Initials
Override Value | I >

Value Type Reason

W s ¥
o g o A J_,].[_"j‘—_’_,ji_ T R el Al S R ::)-‘,_r—-.nf’

=% i

10. Select Sketch from the Building Information Sub Menu, located in the navigation tree on the left
hand side of the screen.

Building Information 2 f3
Construction Details B
Depreciation ;
Condo kain Elaments i}
Azsonated Conidos ’J
Extra Features 53
Building Permits 4
Fires 0
Visit History 7
Building Notes
Photos :
Sketch Cﬁ f,

_Oythuitdie= ..., 8.

11. Enter the Sketch for building two. See Sketching Instructions for directions.
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12. Once all information has been inputted click on the save changes icon

your changes.

File Cards Utilittes Help

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer

" or the F2 key to save
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You are here: Parcel Maintenance > Basic Process > How to Delete a Building from a Parcel with

OVISION

GOVERNMENT SOLUTIONS

How to Delete a Building from a
Parcel with Multiple Buildings

The purpose of this document is to assist the user in removing a building from a parcel that contains
multiple buildings.

S £

% ¢ please note these steps are not intended for removing the primary building from a parcel.

1. Select the parcel from which you want to delete a building.

2. Select Construction Details from the Building Information sub menu, located in the tree on
the left hand side of the screen.

Bullding Information E

Construction Details }

Depreciation 4
£ e 4

Extra Features
Bunlding Permits
Fires

Visit History
Building Notes
Photos

Sketch

i T T

3. This will bring you to the Construction Details Screen.
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4. Select the Building to be deleted. On the top right of the screen use the arrows in the

Building # section to change the selected Building to the one desired for deletion.

;B-uiltﬂngtz o] x| 2 || section: [#] [#| (] 1) of

2

5. Once the Building Number has been Selected, Click the X to delete.

Building #: || [X||[(0||  2/|0)f of 2 E
«| Basement Gar. (wll 7
o= i
r."l",,_, EONE R g ol U e e S _,-s.*I

6. A Delete Building window will appear requesting confirmation that the selected building

number is to be deleted. Click Yes if this is correct.
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O Delete building 2 ?

7. If the Building is allocated a Land Area, you will be prompted to continue the deletion. Click
Yes to continue.

0 Building has allocated land.
Continue deletion?

=

8. Click on the Save Changes icon or the F2 key to save your changes.

File Cards URilities Help
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If there is Land Allocated to the Building that you want to keep on the parcel, you will want
to create an additional Land Line for the parcel first. For instructions, please see Adding a
New Land Line documentation.

Although this Building is no longer in the database, it is not completely removed. This
Building will now be located in the Building Recycle Bin located under the Utilities Menu >
Utilities > Recycle Bin Function > View Building Recycle Bin at the top of the screen. It will
be available for restoration to the database in case of an accidental deletion.

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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You are here: Parcel Maintenance > Basic Process > How to Add a Section to a Parcel

OVISION

GOVERNMENT SOLUTIONS

How to Add a Section to a Parcel

The purpose of this document is to assist the user in adding a new section to an existing building on a parcel.

1. Select the parcel to which the new Section will be added.
2. Select Construction Details from the tree on the left hand side of the screen.

Building Information 2/
Construction Details {
Depreciation 4
Cowcdn Mam B ;
Extra Features :
Building Permits 3
Fires ,{
Visit History ¢
Building Notes r
Photos ¢
Sketch 7

T .

o e U

3

S
AY

¥

Y

\
Y

»~

1. This will open the Construction Detail Screen. This screen will appear different depending on what
moadel (Residential, Commercial, Condo, or Condo Main) the parcel is and the fields your jurisdiction
enabled.

187



0% Kranittan
MELR (10 YT

e VERY SO

M Covnt et

”HH
ii

S UE Coneriind
b R ) e Bk Base
Sty W8 2 g Bawk Rane
Calorew WS} al Astwne

Cunrnl Cadie . 155 ory Carmnd
Sof Shractim V. oses

fuat Cowe 1 LM b

Moot Cover 2

sty WaB Yk et Airn
1 F]

—r FIOOr ¥ hew Mhermwmxs
st Rowr 2

Tirece Aoy )

axt Type (4 Bjes S Simed

Fort Ty 1 (0> Com
funt Type 2

x Type 0 Pee Cordral AW

Tutal Rmmrrns

Pl Sulies:

ol Bali Grate |
Sdt Bty

oaif Bty Grate
s Fatarny
fatrs fature G|

2 | | Section:

=

1[0 of

o

An Add Section prompt will appear.

ST e

e Clicking Yes will copy data from one of the building’s existing Sections.

e Clicking No will require all construction information to be manually populated.

If you opt to copy data form an existing Section, enter the Section Number desired and

click OK.

T
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used to create a new section.

Section Number: ‘ 1

4. The Construction Detail screen will now have the newly created building Section. Change between
building Sections using the arrows in the Section field.

suiding #: [#] [%|[(] 9[[G] or || section: [#][®][]| 23] o zé

.| Basement Garage 1 | . v

>
YR - v~ - - - - -
i y F SRS o g L A W, B R e e T a

b SE S E N

R S R L S

5. Modify any Construction Detail for your new Section.
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Very Important: Fields that appear gray on additional Sections are set to “Only Allow Edit
On Section 1.” Some of these fields may be set to affect value, such as bathrooms. If you
chose to copy data from Section 1, these fields will become populated too. To allow editing
on these fields, see the Construction Detail section in Table Maintenance.

6. Select Depreciation from the tree on the left side of the screen.

189



: Building Information 3
Construction Details
_Depreciation

Extra Features
Building Permits

e = e e e

Fires y
Visit Histary b
Building Notes (
Photos ¢
Sketch . |

7. Select your new building Section and make any necessary changes to Depreciation.
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If the building Section is under construction, enter the code in Condition
(Commonly labeled Status) and enter a Percent Complete.

Depreciation Title ;
Section Level Depreciation !
Year Built 12010 :
Effective Year Built 2010 (w] Ovr EYB /
Functional Obsol [ T i
Economic Obsot | - 7
Condition [UC: Under Consti [ Fagmmmntl ;
PercentComplete (g5 @ :
Depreciation Code | A Average | E
Remodel Rating | - —'!gh j
Year Remodeled ' | Overidenitials
Override Value 1 _ ( - 'l:” ;’
Value Type l'lauon

S == KT e NSRS oo |
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8. Select Sketch from the Building Information submenu, located in the navigation tree on the left
hand side of the screen.

Building Information Bk
Construction Details '5
Depreciation |

Cordn Main Hlemeats
Sssociated Condaos
Extra Features
Building Permits

Fires

Visit History

Building Notes
Photos

Sketch G

9. In the Sketch screen, draw the new Section. See Sketching Instructions for directions.
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10. After creating the shape for the new Section, assign the appropriate subarea codes in the Rectangle
Properties screen by clicking on the code and selecting Add. Next, assign the shape to the
appropriate Section number using the Section ID field.
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FormatSides Subareas |
Avnilable Codes Current Sub Arens
[ Co... | Descrption Co._ | Descnption | co. |
EQP Equipment Busiding 18T IsiFloor 1
FAT Finished AticPlU@ 25 ) Finahed Basemen. 1
FBM Finished Basement-P. 1
FEF Fimshed Enclosad Parch
FFR FastFood Restaurani

Add»
Selected Sub Arven  [1ST
Yert

= You will now see your new polygon with its Section number. Section 1 polygons will not
show a Section number.
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By viewing the Sub Area Summary (2 on toolbar), you will see the Sub Area codes with a
Section number next to it.
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Ecui_j_ Co... | Description | Gross Area | Effective .. | Living Ar.. | ¢
1 25A 25% Attic Finished 2,052 513 513 ;
1 66B 66% Basement Un.. 2,052 308 0 ;
2 1ST  1st Floor 1,632 1,632 1,632 i
2 FB.. Finished Basement.. 1,632 408 1469 /

[ros96  [5089  [s.666 1
J

B G D ey L g Y (AR S

11. Click on the save changes icon H or the F2 key to save your changes.

File Cards Utilities Melp
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You are here: Parcel Maintenance > Basic Process > How to Change a Parcel Status Active Inactive and

O VISION

GOVERNMENT SOLUTIONS

How to Change a Parcel Status
(Active, Inactive and Future)

The purpose of this document is to assist the user in changing a parcel’s status between the three
states of Active, Inactive, and Future.

1. Select the parcel to be modified.
2. Select Account Information from the Legal Information sub menu, located in the tree on
the left hand side of the screen.

Legal information & |
Account Informati
Owner And
Assessment Histo
Other Assessments
Exemptions
Supplemental Data
Abatements
Assessment Change
Parcel Addresses
Assocated Parcels
Notice History
Property Notes (3)
Parcel Audit

.Sub Dmision Hisfory

3. This will open the Account Information screen
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Account Informaton

(¥ 102 s {7 o s Parcel m?km—.tm [t
Account Number | 100506002 W-PB [} Owner Occupied Create Date 10/232004 L
U s Unit Type v
Property Location 1 i IMAINST - g A 355
CityCounty 21p  ANYTOWN 01234 | Primury Use  100R: S5O - Urhan Res ~
StateCountry  MA N (100306002
Owerers Name JOEN S Sl T
Buslding Name Visited
AR 100506002
Cross Street 1
Cross Strest 2
) Yalue Usirozen

4. Parcel Status is indicated on the top right hand corner of the Account Information screen.

("] Edit Mblu Parcel Status | A: Active ™ ;:
[ ] Owner Occupied Create Date 10/23/2014 7
;

/

Legal Area | 43560 _ ,:r

Primary Use | 100R: SFD - UrbanRes |

!

100506002 ¢
] visited 4

R R I S

ot n s P gt e P e i T i il e P S

5. Parcel Status can be changed by clicking in the field and entering the status code of A, F, or
I. You may also click the drop down to select the status code or press the F6 key to activate
the drop down.
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Lega! Area :: 43560

[ JEditMblu  Parcel Status| A: Active | 9] i
{ ] Owner Occupied Create Date | A: Active ;;
F: Future ';
I: Inactive ‘

Y

Primary Use | 100R: SFD - Urban Res [

. —; — =
‘O’V‘MW;-:»"’ I L e

AT

There are three available parcel statuses.

e Active Status (default): Parcel is available for all reporting, valuation and
extracts.

» Inactive Status: Parcel is available for reference but is read only.

¢ Future Status: Allows for data entry but will not be included in reporting, valuation,
or extracts.

6. When changing a parcel to Inactive status, select I: Inactive.

[_] Edit Mblu Parcel Status | A: Active (;,
[ ] Owner Occupied Create Date | A: Active !
F: Future j

I Inactive !

Legal Area [435¢0 | d{

Primary Use | 100R: SFD - UrbanRes  |w|

100506002 ' 7

iRt Y PURENY sb S e R W S Sy LRt W P Y e

7. Vision will then indicate that the status has been changed to Inactive and ask you to save
the data changes. Click Yes.
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0 The current parcel has been set to a status of Inactive.

Do you want to save the changes to parcel data?
Press Yes' to save all parcel data, or ‘'No' ta roliback any changes

8. Vision will inform you that the parcel is now inactive and no changes made to the parcel
will be saved until the status is adjusted to either A - Active or F — Future.

0 The current parcel has been set to a status of Inactive.

Only non parcel related data can be saved while this parcel is

selected. Any changes that are made to the parcel will not be
saved. Please select another parcel.

& #&  The parcel will now be labeled as Inactive.

Parcel Status ’ I: Inactive TL;! f;

| Create Date 10/23/2014 p
¥l

/

P PDY ST L G N S ey SR

' Note: Inactive parcels do not:
* By default print on reports.
¢ By default print as part of a batch of printed cards.

¢ Recalc as a single parcel or batch.
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¢ Extract to Comp Sales or Sales Analysis.

e Extract for billing.

= Print Cost, Land, or Regression reports.

9. If you choose to change an Inactive parcel back to Active you will be prompted with the
following dialog window. This window states that the parcel is now active and the save
button is now enabled again so changes made can be saved.

|ﬁ The current parcel has been set to an active status selection.

The Save button has been enabled. Changes that are made to
parcel data can be saved. You can continue editing the parcel.

10. You can also set the Parcel Status to Future. A parcel marked as Future will not affect the
current values in the database. Entering parcels as Future allows the user to enter parcels
intended for the next fiscal year which can be all changed to Active status using the

Utilities. Please see the Utilities document Make all Future parcels Active for more
information.

Parcel Status | £ Future v]
| Create Date A Active

o = —

F: Future
I: Inactive

Note: Future parcels do not:

¢ By default print on reports.

By default print as part of a batch of printed cards.

Recalc as a part of a batch Recalc.

Extract to Comp Sales or Sales Analysis.

Extract for billing.
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You are here: Parcel Maintenance > Basic Process > How to Make an Improved Parcel Vacant

OVISION

GOVERNMENT SOLUTIONS

How to Make an Improved Parcel
Vacant

The purpose of this document is to assist the user in changing a parcel from an improved parcel (a parcel
containing a structure) to a vacant land parcel.

1. Select the improved parcel you intend to change to a Vacant Parcel.

2. Select Classification & Land Information from the Classification & Land Information sub menu,
located in the tree on the left hand side of the screen.

Classification & Land Information? :{
Classification & Land Information il
Building | vt
Construction 5
Depreciation {
. ; f
| {
"
Extra Features r
e Puilding Dty L 042 T2 e ="
3. The Classification & Land Information screen will open.
L - - - ’ =
Ui 041 Pulsls Wipter ;‘ Woest’ 1. Pornd Roet o kméMum 01 Food Aen = Topl 1) ey =
=z 2 B e - =4
Ut 03 Puble S = e 0% CustCanm ® Footesy 00 N/ wl sk Type (0 WA -
U 00 M L S 00 N o amemann 03 WA » Locaton 03 & ¥
Lol V biatar Samght e ooy - — ) adl Facmany
(L] M W @ tegn } bromage Owm'o B fom: ¢
Conws Nk 000 ML % [N——— SocFromupe ¢ Besetir 0 Gt Parmenes 0
2 Comtaiin: o lromtage. 0 = Bype' -
| Sakiing Clissmcancn el Loms Lng Vak.ation
Mags ‘Ume® Cote Dwsoption Unan il "o Avpmrzent hce Borw M Lt Ty Cu
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C ™
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4, Click on Edit Lines.

Busding Classfcation Al Land Line Vakuaton
Uit Acre ‘Land

Bdg» iwee (ode Descripten ,u“,l Type »w A Asseszed o “Tom Type Lang Type Dese :
PoAs oA s N00R SED - Urbenfies e ARSE0 SF 0 SIASR0M0 oo SIREO000 o cowie BOME R i s s
Lane Acres t Appraised $32.99000 |__ i_'“_ Unes _]
Wix Use
100R  SFD - Urban Res 100 K

5. The Use Code must be changed to represent a Vacant Use.
« % The code can be changed in two ways.

* Type the Vacant Use code into the Use Code field.

» Use the drop down menu either by clicking on the drop down arrow on the Use
Code field or click on the field and hit the F6 key.

Bldg # Line # 7
Use Code* 00R: SFD - Urban Res @ t ]
Zoning 100T: SFD - Urban MH ap77 /
Dt 100U: SFD - Urban Condo ,; 00000000 /
100V: SFD aUrban Vacant LOO 4

Frontage 200C: SF budban - Comm ; ;
Depth 200E: SFD - an - Exempt {
Uniits 200F: SFD - Suburban - Farm 000 :
) 200R: SFD - Suburban — 1
Unit Type 200T: SFD - Suburban - MH ' i
200U: SFD - Suburban - Condo = 1

- " —— _-:,' ';

Special Calcs | E| -

Notes ‘

6. Once the Use Code has been changed, a Use Change affects Construction Detail prompt will
appear, Select Yes to make the parcel vacant and remove the construction information.
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Changing from 100R to 100V will cause the deletion of any
construction information! You will need to rekey Construction
information in the new form.

Proceed with change?

7. Another Print Current Building prompt will appear. It is recommended that the card is printed
for your records. Select Yes to Print the Card.

Would you like to print the card for this building with the current
information, prior to changes?

8. If the parcel has an Outbuilding/Yard Item, a Warning prompt will appear, click OK to continue.

When changing land use to vacant, verify that the outbuildings still exist!

Fa

-."-”';,,- Verify the Outbuilding exists. If not, see How to Delete an Outbuilding.

9. Click Close on the Land Details screen.
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UseCoder  |ESFD~Lirban Vaceedt ¥ | Land Type

Boring ' ol gmce 077
Davict i influsence Factar * 0000000
LT . Conamion Facto 100
et / N i,
i 4 ! * 000
Urits 3560000  Nbhd Ady . !
Uniit Type | 58 Square Foet » Sxee Adust 2 I
Speosi Caks -
Notes
Special Use fw wieh %

1_; Override hppraised Lang Vatue
Owerride Assessed Land Line Value

Totals
Appraised 33500 m@q:

(CNea ] [TAd] | oeee | [TC0se )

10. Click on Construction Details from the Building Information sub menu, located in the tree on
the left hand side of the screen.

Building Information ]

Building Permits
Fires

Visit History
Building Notes (3)
Photos

e TR S e e il ]

]

R S .

ot R PTG

11. Change the Style and Model to represent a Vacant Parcel.
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Mode 00:Vacant £ w—"10
Style 99: Vacant Land e
Grade [«]  AcType :
Stories Bedrooms fl
Foundation Type * | Totat Rooms j
Foundation Type : [«| FullBaths %
Exterior Wall 1 |  Full Bath Grade:

R

Y o R Wy A i BT S e b el Ha{faath&,/
The Model and Style can be entered in two ways.

e Type the Vacant code into the Model and Style field.

* Use the drop down menu either by clicking on the drop down arrow on Model or
Style field or click on the field and hit the F6 key.

H

12. Click on the save changesicon * ° or the F2 key to save your changes.

File Cards Utilities Help

MY =2 IW

tion Exploser v 3 x l‘l

<«

If you pressed the F2 key, Vision will ask if you want to save changes. Click Yes.

Cancel

© 2019 Vision Government Solutions Inc. All Rights Reserved.
1 Cabot Rd. Hudson, MA 01749 (800) 628-1013 www.vgsi.com
Equal Opportunity Employeer/Affirmative Action Employer
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